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Order Entry Operations Guide

Introduction
Welcome to CertiflexDimension Order Entry!
This Operations Guide is designed to help you get started using the program.
It is organized for first time users and details the steps you need to follow
once the system is installed. It can also be used as a reference for day to day
processing.
To get the most out of CertiflexDimension Order Entry and to guard against
wasted definition time, it is very important that you read this guide and
familiarize yourself with the product before you begin processing.
This guide is used in conjunction with the CertiflexDimension System
Manager Guide. The System Manager Guide details CertiflexDimension
terminology, functions, general program overviews, general program buttons,
and fields. It also shows you how to:
Configure Users and Define System Security
Configure User Defined Memos
Change the Processing Date
Add Companies
Print Reports
It is extremely important that you read the System Manager Guide before
you begin using the Order Entry program.
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What You Need To Know First
This version of CertiflexDimension is a Microsoft Windows® application. You
must be familiar with Windows before you can use the Inventory program.
The CertiflexDimension Order Entry program is used in conjunction with the
CertiflexDimension Accounts Receivable program. We strongly recommend
that you read the Accounts Receivable Operations Guide and set up your
Accounts Receivable program before using the Order Entry program.
Before you begin, make sure that you have correctly installed
bothCertiflexDimension Accounts Receivable and Order Entry programs. The
CertiflexDimension Accounts Receivable program must be installed on your
computer in order to use CertiflexDimension Order Entry. To install the
programs, refer to the Installation Instructions in your package.

Start-Up Cycle
You are ready to begin processing after you:
Install CertiflexDimension,
Read the CertiflexDimension System Manager Guide,
Read the Accounts Receivable Operations Guide,
Read the Order Entry Operations Guide, and
Add Companies to your System
NOTE: If you are converting from CertiflexDimension version
9.0, you do not need to perform the start-up functions.
Please use the following Schedule of Events as a guide to using the
CertiflexDimension Inventory program.

Schedule of Events
Order Accounts Receivable/Order Entry invoice forms: If you did not
perform this step when you installed the Accounts Receivable system, you
should order your invoices now. However, the system is pre-set to print
sales orders and invoices on plain, 8½" x 11" paper. This allows you to
avoid the expense of obtaining preprinted forms or allows you to
immediately begin printing before forms arrive. The CertiflexDimension
Order Entry program includes several default forms. Enclosed with your
CertiflexDimension order is a Certiflex Forms brochure for ordering
forms. If you have any questions about the invoice form or style, call
Certiflex Forms directly at 800-544-3427.
Create the company files: Before you begin processing with Order Entry,
you must first create company files. Refer to the CertiflexDimension
System Manager Guide to properly create company files. The Order
Entry system is used in conjunction with the CertiflexDimension
Accounts Receivable system. You must set up the Accounts Receivable
module for this company prior to entering customer sales orders. For
5

more information on Accounts Receivable, please refer to the
CertiflexDimension Accounts Receivable Operations Guide.
Define the Master Data: A part of creating company files is to define the
company's Master Data. The Order Entry program does not have a
Master Data section. The Master Data information for the Order Entry
program is found in the Master Data section of Accounts Receivable.
Refer to the Defining the Master Data section for an explanation of Order
Entry Master Data.
Make a backup: After adding your Order Entry information, you are
ready to begin normal processing. It is very important that you make a
backup of the Order Entry data files to guard against the possibility of
losing your work.

Order Entry Transaction Processing Cycle
The Order Entry Transaction processing is comprised of three specific steps.
Step 1: Record Sales Order: Use this step to add, change and delete sales
orders. Sales Order detail lines that have been shipped but not invoiced
cannot be edited. Sales Orders that have lines shipped but not invoiced
cannot be deleted.
Step 2: Record Shipments: Use this step to record the shipment of items
to customers.
Step 3: Record Invoices on Shipped Orders: Use this step to print
invoices and update customers for shipped items. This step may have
been done at the time of recording shipments.
A Sales Order is considered complete once all items have been both shipped
and invoiced.

Order Entry Tracking Files
The Order Entry System uses the following tracking systems.
Open Orders: The Open Order file contains all orders that have been
recorded and possibly shipped but not invoiced.
Closed Orders: The Closed Order file (completed) contains all orders
that have been shipped and invoiced. If you are tracking backlogs and
have shipped and invoiced a partial order, the system will record the
completed portion of the order to the Closed Order file and adjust the
remaining portion in the Open Order file.
Discarded Orders: The Discarded Order file (deleted) contains all
unshipped backorders automatically deleted by the system and orders
manually deleted but tracked for analysis purposes.
Quotes: Quotes are recorded potential orders. Any open quote can be
transferred to the open order system by selecting the option Transfer
Quotes to Orders.
Archived Quotes: Old Quotes may be archived into previous year files.
Any archived quote can be transferred to the open order system by
selecting the option Transfer Quotes to Orders.
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Defining the Master Data – Order Entry

Company Master Data
Company Master Data Settings allow you to configure the Order Entry
program to fit each company's needs. Configuration is very flexible. Fields
defined in this option are very important as to how the program will operate.
Please read this section so you can define the Master Data in the manner
best suited for the company.
The Order Entry program is used in conjunction with, and will not function
without, the Accounts Receivable program. The Master Data information for
Order Entry is found in the Accounts Receivable Master Data. The Order
Entry section of the Accounts Receivable Master Data is defined here. For a
full explanation of the complete Accounts Receivable Master Data, refer to
the Defining the Master Data section in the Accounts Receivable Operations
Guide.
To open Master Data, click >File >Company Maintenance >Master Data
Properties. Click Accounts Receivable & Order Entry.
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Agings
Select the Agings tab to define the Master Data aging information for the
CertiflexDimension Order Entry program.

Order Entry Anticipated Shipments Schedule
Heading Column One, Heading Column Two, Heading Column Three,
Heading Column Four: These fields allow you to specify the column
headings that will print on the Anticipated Shipments Schedule reports.
The system will allow you to enter anything that you like for the
headings. You will normally want to define each heading to correspond to
the Number of Days fields on the right. Otherwise, the Anticipated
Shipments Schedule reports may be difficult to understand because the
system uses the Number of Days fields for anticipated shipment
calculations.
Number of Days Column One, Number of Days Column Two, Number of
Days Column Three: These fields allow you to specify what column each
order should go in based on the expected ship date of each order and the
system date used when printing the Anticipated Shipments Schedule
reports.
o

Number of Days Column One specifies how many days past the
current processing date an order's expected ship date must be before
it will move from column one to column two.

o

Number of Days Column Two specifies how many days past the
current processing date an order's expected ship date must be before
it will move from column two to column three.

o

Number of Days Column Three specifies how many days past the
current processing date an order's expected ship date must be before
it will move from column three to column four.
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Orders
Select the Orders tab to define the Master Data sales order and quote
information for the CertiflexDimension Order Entry program.

Order/Quote Numbers
Precede with Year/Month and Auto-Reset: Next Order or Quote Numbers are
by default sequential. Select this option if you prefer to have the system
automatically reset the order number each new accounting period.
Example: The starting Order Number for Sept. 2008
is 0809-001
Each new order or quote will increment sequentially
(i.e: 0809-002, 0809-003, etc.)
The first order entered in the next accounting period
will automatically reset the next order number to
0810-001
NOTE: If you envision needing more than 1000 orders or
quotes in any single accounting period and you are using the
‘Auto-Reset’ feature, set the next order number after the dash
to four digits (YYMM-0001). This will allow up to 9999 orders
and quotes in any single accounting period.
Next Order/Quote Number: The system will use the number defined in
these fields as the next transaction number when you enter orders or
quotes. Define here what the system should use as the next number. As
you process order and quotes, the system will increment the numbers in
this field. The next order or quote number is a 10-digit alphanumeric
counter and can be changed as needed. Since most Order Entry options
are printed and selected by Order Number, you would normally not
change this number in a manner that duplicate numbers will be
encountered.
Increment by (1-10): You can define the number of skipped numbers
between each order or quote number. Select an increment from 1 to 10.
The default increment is 1.
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Pre-Assign New Order Numbers: Check this box if you want the system
to assign new order numbers as described above. Using this method, a
new order number is assigned when a user clicks >Start from the Record
Customer Order system. This order number is then discarded if the new
order is never saved.
NOTE: If the Pre-Assign New Order Numbers feature is
disabled, the system does not assign an order number to new
orders until the order is saved. Also, the Allow User to
Change Order No. and Increment By functions will be
automatically disabled, as well.
Allow User to Change Order No: The system will automatically assign
the next order or quote number to each new customer transaction. Select
this option if you wish to be able to override this pre-assigned next
number.
Assign Separate Quote Numbers: Check this box if you want the system
to assign different numbers for orders and quotes.
NOTE: Selecting this option will automatically assign new
quotes a number starting with the letter ‘Q’ and followed by a
two digit year and two digit month. Quotes will then be
assigned a new order number if they are later transfer into an
order. If you do not select this option, then new quotes are
assigned a new order number when recorded and this number
is not changed if the quote is later transferred to order.

Sales Orders
Message One, Message Two: These fields allow you to enter any message
you want to print on each of the sales orders, such as promotional
information or customer reminders.

Other
Allow Auto-Deletion of Backorders: Select this check box if you want the
system to allow users to activate the “Backorder Auto-Deletion” feature.
Leaving this option unchecked will not allow any orders to be “Auto-Deleted”
upon partial shipments.

Shipping
Show Customer Status: Select this check box if you want the customer’s
current account aging amount to be displayed when recording their
shipments. If this feature is disabled, the Record Shipments account status
field will read Not Activated.
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Maintain Lists – Order Entry

Sales Order Management
This section explains how to perform management functions on the Order
Entry System. Management options are available for manager analysis,
maintaining shipping carriers and group delete functions.
To access Sales Order Management, click >Maintain Lists >Order Entry
>Sales Order Management.

Manager Reports and Group Deletes

Manager Reports
Sales Order Analysis
Sales Order Analysis is designed to present summary management
information about the Sales Order system for this company.
Analysis Period: Select one of the following period types:

o

By Day: Select this period type to display the analysis by day for the
last 7 days.

o

By Week: Select this period type to display the analysis by week for
the last 8 weeks.

o

By Period: Select this period type to display the analysis by period for
the last 6 periods.

Ending Date: Select the ending period date to use in the analysis.
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Include Quote Analysis: Select this option if you wish to include quotes
in the analysis.
To display the analysis, click >Ok.

Unusual Days to Complete List
This option is designed to list orders that took an unusual number of days to
complete. For example, if your company usually processes orders in 5 - 8
days, you might want to see a list of orders that took longer than 8 days to
complete. Days to complete are calculated from the original order date to the
invoice date.
Analyze Order Records On or After: Select the date on or after which you
wish to include.
Show Orders with Number of Days to Complete Over: Select the number
of days to complete that you wish to use.
To display the list click >Ok.

Unusual Days to Ship List
This option is designed to list detailed order lines that took an unusual
number of days to ship. For example, if your company usually ships items
within 2 days of expected ship dates, you may wish to see a list of items that
shipped 3 or more days after their expected ship dates. Days to ship are
calculated from the original detail lines expected ship date and the actual
date shipped.
Analyze Order Records On or After: Select the date on or after which you
wish to include.
Show Orders with Number of Expected Ship Days Over: Select the
number of days to ship that you wish to use.
To display the list click >Ok.

Group Delete Options
Group Delete Options are designed to allow a manager to make group
deletions from the Order Entry system. Orders deleted using Group Delete do
not include the additional verification available to data entry clerks deleting
a single order under Record Customer Orders. Care should be taken when
using Group Delete, especially when deleting open orders.
To Group Delete orders, select from the following order types by clicking on
the corresponding button: Delete Open Quotes, Delete Closed Orders,
Delete Unshipped Backorders, or Delete Open Orders. A new window will
open displaying the orders available for deletion.
To select multiple orders to delete, hold down the shift key and click the
desired orders. Once all the orders you wish to delete have been selected,
click >Delete Selected Orders.
Using this option to delete open orders will not track unshipped backorders.
You should also Recalculate Quantities to Ship after you have deleted open
orders that contain inventory items.
When performing the Delete Open Orders process, if you delete open orders
that have already been shipped but not invoiced, you will need to manually
invoice these orders in the Accounts Receivable program.
NOTE: You should always have two current backups of all
order entry files before using group Delete. Quotes, closed
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orders and unshipped backorders can be compressed using
Compress Date Files under the File menu of Data File
Maintenance.

Maintain Shipping Carriers

Shipping Carriers
These options allow you to define the shipping carriers you use to transport
your orders.
Adding New Carriers: To add a new shipping carrier, click >Add. The
system will prompt you for the following:
o

Number: Enter up to a 10-digit carrier ID number.

o

Name: Enter up to a 30-digit carrier name.

o

Ship ID: If this carrier uses shipment tracking IDs that include a
consistent company specific number at the beginning of the tracking
ID, enter the consistent part of the tracking ID here. The system will
automatically insert this consistent part of the tracking ID number
on each order transported by this carrier.

o

Shipping Methods 1- 6: Enter up to six specific shipping methods per
carrier. Shipping methods are used during Record Shipments and
reported on the Carrier Report.

Modifying Carrier Information: To make changes to an existing carrier,
highlight the carrier in the carrier list and then click >Edit. The system
will allow you to modify all the criteria listed above (Number, Name, Ship
ID, and Shipping Methods).
Deleting Carriers: To delete a carrier, highlight the carrier in the carrier
list and click >Delete.
You may optionally change the order of the carriers in your carrier list by
selecting the carrier you wish to move and then clicking the up/down arrows.
The first carrier in the list is considered the default carrier for recording
shipments.
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Archive Quotes

After a period of time, the Open Quote system may become slow and
unwieldy if older quotes are not periodically deleted or archived. Archiving
older quotes allows you to still review and/or transfer these quotes for a
period of 10 years, while freeing up space for faster processing.
This option automatically archives quotes by calendar year. To archive
quotes, select the Earliest Date to Keep and then click >Archive Now.
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Transactions – Order Entry

Record Customer Orders
This section

explains how to record sales orders. This option allows you to
add, change, and delete orders. The input of orders is normally the first
step you perform in the order entry process.
NOTE: If you are operating interactively with the
CertiflexDimension Inventory program, sales order validation
will update the quantity on backorder (committed quantity)
for each inventory item included on the order.
To access customer orders, click >Transactions >Order Entry >Record
Customer Orders.

Adding New Orders - Select Customer and Start Transaction
Order/Quote Type: Select one of the following transaction types:
o

Regular: Select this type if the order you are entering is not prepaid.
After an invoice is printed for Regular orders, an open item for the
amount of the entire shipment will be created on the customer
account.

o

Cash: Select this transaction type if the transaction is a prepaid or
cash transaction.
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If you select this transaction type, the system will not track an open
item for the sale. Normally, when you invoice a shipped order, the
system will record a debit to the accounts receivable account and a
credit to the sale’s sales code account. When you record a cash sale,
the system will record a debit to cash account, or undeposited cash
account if you are using the Deposit System and a credit to the sales
code account.
Customer: Select the customer for which to record the sales order.
NOTE: When a valid customer is selected, click Start to record
a new sales order for the selected customer or simply doubleclick on their account in the customer listing.

Output Mode
Select the desired order form output. To have the forms printed based on
customer output preferences, select By Customer. To have no forms printed,
select None. To have the system prompt you for output destination prior to
printing, select Prompt.
Settings
Forms and Printers

Selected Form: This section displays the form currently selected to print
orders. To print a different format, select from the drop down menu.
NOTE: CertiflexDimension v10 has a new feature where form
preferences can be customized and set per customer by
selecting the Calculate (By Customer/Output) form. This
feature may be implemented during any order, quote or
invoice printing process that displays a Forms & Printer
Selection prompt.
For additional information on setting up and using multiple
invoice/order/quote forms based on customer and output,
please refer to the CertiflexDimension Form Designer section
of your System Manager Operations Guide and the Maintain
Customers >Adding a Customer >Additional Options
>Statement/Other section in your Accounts Receivable
Operations Guide.
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Selected Printer: This section displays the printer currently selected to
print. To use a different printer, click on the Printer Setup… button.
Printer Output: Select the check box that corresponds with your preferred
means of output, either Selected Printer or Preview Screen.
Copies: Enter the number of copies you want printed.
Click >OK to save your form and printer selections and return to the Select
Customer & Start Transaction screen.

Preferences

Settings
Always Ask Retainage after Job Number: Select this checkbox if you’d
like the system to prompt you for a retainage amount when assigning
jobs to invoices/orders.
Append Customer Name: The system can optionally display a
description of the transaction type selected (abbreviated) and the name of
the customer. This is convenient if you do many transactions to special
type customers (customers with a Class of 98) or cash customers.
Maximize Transaction Entry Screen: Select this checkbox to have the size
of the transaction entry screen maximized. If your screen display mode is
1152 x 864 or greater, you will be able to view a full transaction screen
without scrolling with this selection.
Calculate Aging for Invoices: Select this checkbox to have the system
automatically calculate aging data which can be included in Rave Invoice
forms. If you do not include account balances and aging in your invoice
forms, leave this option unselected as this option will slow down form
processing.
Default Payment Type: Select the most common payment type from the
dropdown list: 1 – American Express, 2 – MasterCard, 3 – Visa, 4 –
Discover, Other Credit Card, 5 – ACH Credit, 6 – Cash, or 7 – Credit.
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Default Line Type: Select your most common detail line type from the
from the dropdown list: O – Description, 1 – Regular, 2 – Quick
Inventory, or 3 – Inventory.
Fax Printer
Select the desired fax printer device from the dropdown menu. To reset the
device selected, click on the Clear button.
Output Mode
This option defines how the system will designate invoice/order form output
destination. To have the forms printed based on customer output preferences,
select By Customer. To have no orders printed, select None. To have the
system prompt you for output destination prior to printing, select Prompt.
Default Lists
Print Terms: The CertiflexDimension Accounts Receivable system ships
with several default print terms defined, such as Due Upon Receipt,
C.O.D. Check OK, and C.O.D. Cash Only. The system will allow you to
add or edit print terms. When you click this button, the system will
display a list of the default print terms. Simply add additional print
terms you would like to have available. Each print term must be listed
on a separate line.
Transaction Descriptions: The CertiflexDimension Accounts Receivable
system ships with several default transaction description terms defined.
The system will allow you to add or edit transaction descriptions. When
you click this button, the system will display a list of the default
transaction descriptions. Simply add each additional default transaction
description term you would like to have available. Each term must be
listed on a separate line.
Special Instructions: The CertiflexDimension Accounts Receivable
system ships with several default special instruction terms defined, such
as Ship Two Day, Ship Next Day, and Customer Pick-Up. The system
will allow you to add or special instructions. When you click this button
the system will display a list of the default special instructions. Simply
add each additional default special instruction term you would like to
have available. Each term must be listed on a separate line.
Prompts
Transaction Heading: This option allows you to change most prompts on
the heading section of Record Invoices/Orders. Uncheck any items you
do not want in the tab order.
o

Change Prompt Label: The system will allow you to change the
name of a heading label to best suit the way your company does
business. To change the name of a label, highlight the name of the
prompt you want to change and click on the Change Prompt Label
button.

o

Save: When all of your heading prompts have been changed, click on
the Save button to save the changes made.

o

Cancel: Click on the Cancel button if you do not want to save the
changes made to the heading prompts.

Detail Lines: This option allows you to change most prompts on the
Detail Lines section of Record Invoices/Customer Orders. Uncheck any
items you do not want in the tab order.
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o

Change Prompt Label: The system will allow you to change the
name of a detail line label to best suit the way your company does
business. To change the name of a label, highlight the name of the
prompt you want to change and click on the Change Prompt Label
button.

o

Save: When all of your detail line prompts have been changed, click
on the Save button to save the changes made.

o

Cancel: Click on the Cancel button if you do not want to save the
changes made to the detail line prompts.

Orders/Quotes
Email New Order/Quote Confirmation: Select your preferred method of
email confirmation, either Confirmation Only or With Attachment.
Auto-Delete Backorder after Invoicing: Select this checkbox if you want
the system to automatically delete backorders affected by invoicing.
When you have finished setting your preferences, click on the Save button to
save the preferences and return to the Select Customer & Start Transaction
screen.
To return to the Select Customer & Start Transaction screen without saving
these changes, click on the Cancel button.
Open Order Options
Select the Open Orders tab to view all open orders for the selected customer
account. You may then choose the following Order Options, displayed to the
right of the order listing.
Repeat Order
You can create a new order containing the exact detail from one of the
customer’s open orders. After the customer has been selected, click on the
Open Orders tab and the system will list all of the customer’s current open
orders. To repeat an open order, select the order from the list and click
>Repeat Open.
The system will then display the Record Customer Order screen. For more
information on modifying or saving the order, refer to the Record Customer
Orders: Transaction Header and Record Customer Orders: Transaction
Detail sections of this guide.
NOTE: Repeat Previous Order copies all existing detail lines
from the previous order selected. All customer information
such as address, terms, credit limit, etc. are retrieved from
customer record
Edit Order
You can edit any existing open order that has not been invoiced. To edit an
existing order, click >Edit Order and double-click on the order you wish to
change.
The system will then display the Record Customer Order screen. For more
information on modifying or saving the order, refer to the Record Customer
Orders: Transaction Header and Record Customer Orders: Transaction
Detail sections of this guide.
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NOTE: You cannot delete or edit detail lines that have been
shipped but not invoiced.
Delete Order
You can delete any existing open order that has not been shipped. To delete
an existing order, click >Delete Order, select the order you wish to delete and
click >Ok. The system will ask you if you wish to track the deleted order for
analysis purposes. If you select Yes, the system will track the deleted order
in the Discarded Order File. If you select No, the system will delete the order
without tracking.
NOTE: You cannot delete an order that has been shipped but
not invoiced.
Find Open Order
To locate an existing open order, click >Find Open Order and a listing of all
open orders will be displayed.

Double-click on the desired open order and the system will return you to the
Select Customer & Start Transaction screen with that order and customer
highlighted for selection.
Transfer Quote to Order
To locate the selected customer’s open quotes and transfer them to the order
system, click >Transfer Quote to Order. A listing of the customer’s open
quotes will be displayed.
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Double-click on the desired quote and the system will transfer
the quote information to an active order, as displayed on the Record
Customer Order screen. For more information on modifying or saving the
order, refer to the Record Customer Orders: Transaction Header and
Record Customer Orders: Transaction Detail sections of this guide.

Closed Order Options
Select the Closed Orders tab to view all closed orders for the selected
customer account. You may then choose the following Order Options,
displayed to the right of the order listing.
Repeat Closed Order
You can create a new order containing the exact detail from a customer’s
closed order. After the customer has been selected, click on the Closed
Orders tab and the system will list all of the customer’s closed orders. To
repeat a closed order, select the order from the list and click >Repeat Closed.
The system will then display the Record Customer Order screen. For more
information on modifying or saving the order, refer to the Record Customer
Orders: Transaction Header and Record Customer Orders: Transaction
Detail sections of this guide.
NOTE: Repeat Previous Order copies all existing detail lines
from the previous order selected. All customer information
such as address, terms, credit limit, etc. are retrieved from
customer record
Find Closed Order
To locate an existing closed order, click >Find Closed Order and a listing of
all closed orders will be displayed.

Double-click on the desired open order and the system will return you to the
Select Customer & Start Transaction screen with that closed order and
customer highlighted for selection.
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View Closed
To view a closed order, select the order from the Closed Order listing and
click >View Closed. The system will then display the Review Order Entry
screen for the selected closed order.

For more information on the fields displayed on the Review Order Entry
screen, please refer to the Review Orders section of this guide.
The very top of the main Record Customer Orders screen shows the type of
transaction you selected, the selected customer, and the following auxiliary
buttons:
Order Memos
Shipping Notes
notes.

: Click this button to add a memo to the order.
: Click this button to record any additional shipping

Customer Ship to Key List
: If multiple shipping addresses are
defined for this customer, click this button to have the system display a
list of available shipping address. Select the shipping addresses to use
for this transaction, then click on the Ok button.
Customer Contact List
: If multiple contacts are defined for this
customer, click this button to have the system display a list of available
contacts. It will list all the contacts that were added in the Contact List
section of Accounts Receivable >Maintain Customers. Select the contact
you wish to use for this order, then click on the Ok button.
Copy Bill To Information to Ship To
: Click this button to copy the
customer’s billing address information to the shipping address
information fields.
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Transaction Attachment [F8]
: Select this option if you wish to add an
attachment to this order. For more information on how to add advanced objects like
video or sound to an attachment, please refer to your CertiflexDimension System
Manager Guide. Attachments do not print on invoices or orders, but may be
displayed later by accessing the Customer Account Detail in Accounts
Receivable >Review Customers or in Order Entry >Review Order.

The detail data entry screen will automatically scroll through the sections of
the order as you enter data. You may optionally toggle between the
Transaction Header section and Transaction Detail section by pressing the
[F9] key.

Transaction Contact and Addresses
Contact: The customer’s contact information will appear in the Contact
field. To change the customer contact information, click on the Customer
Contact List button.
NOTE: You may optionally use the contact field for any
addition information you wish to save with each order
(maximum 256 characters). By default, the contact field does
not print on invoices or orders, but may be added using the
Rave Forms Generator.
Bill To: The system will display the customer's billing address
information as defined on the customer's main record. To edit the billing
address information, you must exit this program and change the
information in the Accounts Receivable >Maintain Customers section.
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NOTE: If the customer has the class field set to 98 or 99, you
can edit the billing address information on this screen.
Ship To: If the customer has a shipping address defined on their main
record, that information is displayed here. The system will allow you to
make adjustments, if necessary.

Transaction Header
Order Number: If you have enabled Pre-Assign New Order Numbers in
the Order Entry Master Data, the system will automatically assign a new
order number each time you enter a new sales order. The new order
number sequencing is based on the Master Data’s defined Increment By
number. If the Allow User to Change Order No. feature has also been
enabled, you may optionally change the order number.
NOTE: You should try to avoid duplicate order numbers if
possible when manually changing numbers.
By default, sales order numbers are incremented and pre-assigned when
a user starts a new order. The new sales order number will be skipped if
the user does not elect to save the new order. For internal control
purposes, each order also contains an internal Order ID which is
sequentially assigned as each new order is saved. All Order Entry files
support printing and reviewing orders by the Order ID. However, if PreAssign New Order Numbers has been disabled, the Order No. field will
display Auto-Assign. In this mode, you may optionally tell the system to
pre-assign an individual order number by clicking on the clipboard icon
.
Description: Enter a description for this order. The system will allow you
to index on this field when you reviewing and printing orders. If you leave
this field blank, the system will automatically input an order description
for you. The description the system will input is the first part of a
customer name followed by the order date.
Cancel Date: If you want this order to be canceled if it is not shipped
complete by a certain date, you can enter that date here. This is an
informational field only and is not required by the system.
Order Date: Enter the order date for this sale. The system will default to
the current processing date.
Purchase Order Number: If applicable, enter the customer's purchase
order number. If you enter a purchase order number, the system will
save the purchase order number to the customer's history file. The
system will automatically check to insure that the purchase order
number has not already been used for this customer.
Terms: The system will default to the customer's defined terms on the
customer's main record (Type 0). If you want to select a term other than
the customer's default, select from the following:
o

Type 1 - Select Number of Days from Invoice Date: Select this
option if this transaction is due a set number of days after the
transaction date. If you select this option, the system will prompt you
for the following:
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o



Number of Days Until Due: Enter the number of days after
the transaction date that the transaction is due.



Discount Percent: If a discount percentage is allowed for this
customer for early payment, enter the allowed discount
percentage.



Number of Discount Days: If you entered a discount
percentage above, enter the maximum number of days from
the transaction date that the customer must pay the
transaction by in order to receive the discount.

Type 2 - Select Number of Days from End of Month: Select this
option if this transaction is due a set number of days after the end of
the month. If you select this option, the system will prompt you for
the following:


Number of Days from End of Month: Enter the number of
days after the end of the month that the transaction is due.



Discount Percent: If a discount percentage is allowed for this
customer for early payment, enter the allowed discount
percentage.



Number of Discount Days: If you entered a discount
percentage above, enter the maximum number of days from
the end of the month that the customer must pay the
transaction in order to receive the discount.

o

Type 3 - Select Specified Due Date: Select this option if you want to
define this transaction due on a specific date. If you select this
option, the system will prompt you for the due date.

o

Type 4 – Reset To Customer Terms: Select this option if you have
changed the terms and decide to revert back to the terms set up on
the customer record.

Print Terms: Enter or select the payment terms you want the system to
print on the invoice. The system will first default to the print terms
defined for the Master Data field Print Terms. If there are no print terms
defined in the Master Data, the system will default to the terms used in
Transaction Terms above.
You can use this field to have the system print terms that are different
than the customer's true terms for the invoice. For example, if the
selected customer's payment term is defined as Net 30, in an effort to
cause the customer to pay more quickly, you may wish to have the invoice
print terms of Net 10. The system will still save and age the invoice as
Net 30. The terms printed on the invoice are the only place the Net 10
will display.
Invoice Number: This number is always assigned by the Order Entry
system when invoicing shipped orders.
Special Instructions: Enter or select any kind of message that you would
like to print as special instructions on the invoice.
Transaction Description: Enter or select the description for this
transaction. The description entered here is saved to the customer's open
item and history files and to the transaction files. The system will
default with a description of the transaction type you selected (Invoice,
Credit Memo, Debit Memo, etc.).
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Salesperson: Select the salesperson for this transaction. The system
will default to the salesperson defined on the customer's main record.
The system will only allow you to select one salesperson per transaction.
If you need to distribute this transaction to multiple salespersons, you
must either generate multiple transactions to separate the sales
amounts, use the commissions override feature or manually update the
salesperson's commission amounts.
Commission Percentage: If the Master Data field Display Commissions
is selected and the salesperson selected has a commission percentage
defined, the system will default to that commission percentage for this
transaction. Select or edit this commission percentage.
If the salesperson's commission percentage defined is a negative percent,
the system will prompt you for the commission rate for this transaction.
Job Number, Job Name: If you are operating the CertiflexDimension Job
Cost program, the system will prompt you for the job number this
transaction should be posted to. Select the correct job number.
NOTE: Before the system will allow you to record a
transaction for a customer to a job, the customer MUST have
retainage activated on their main record. The normal setting
for retainage for customers is turned off. You will need to
either set the retainage to a percentage or to a percentage of
0.000%. If the Retainage Percent field for the customer is set
to -1.000% open Accounts receivable >Maintain Customers,
click > the additional tab, and set the percentage to 0.000% or
higher. Setting the retainage percentage to a -1.000% will
deactivate the retainage field.
When the Heading fields are completed, you will be moved to the Transaction
Detail section to enter the transaction detail lines.
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Transaction Detail

There are five types of transaction detail line items you can enter from this
screen: Description Only Lines (Type 0), Regular (Type 1), Quick Inventory
Lines (Type 2), Inventory Lines (Type 3), and Inventory Kit Lines (Type 4).
There are also special transaction functions you can perform from this screen:
changing the discount percentage, changing the tax information, and
changing the freight amount.

Regular Detail Lines (Type 1)
Regular detail lines include all detail line types except for those lines
involving specific inventory items maintained in the CertiflexDimension
Inventory program and description only lines.
To enter a regular detail line, enter a “1” for the Line Type. The system will
allow you to enter the following information:
Sales Code: Select the desired sales code to use. Press F6 for a listing of
your sales codes.
As described in the Accounts Receivable >Maintain Sales Codes section,
the CertiflexDimension Accounts Receivable program allows you to
develop sales and cash receipt totals for posting into the General Ledger.
The system maintains the totals to post to the General Ledger through
the use of sales codes. You are required to enter a sales code for each
detail line of every transaction that you record in the system. It is
important that you be consistent in the use of the sales codes to allow the
system to most efficiently summarize all sales entries in preparation for
posting to the General Ledger.
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There is a detailed discussion of the system's use of sales codes in the
Maintain Sales Codes section. We recommend that you read and
understand this section before continuing with this option.
Unit of Measure: Enter the detail line's unit of measure. If the sales code
used is defined with a default unit of measure, the system will display
that default unit of measure.
Taxable: The system will show you if this sales code is taxable.
Discount Percentage: Enter this detail line's discount percentage. The
system will let you enter a percentage in this prompt only if the Master
Data field Discounts is set to Discounts Per Line.
Commission Percentage: Enter the correct commission percentage for
this detail line for the selected salesperson. The system will display this
prompt only if the field Ask Commission on the selected sales code and
the Master Data field Display Commissions are selected.
Description: Enter the description for this detail line. The system will
default to the invoice description of the sales code you used for this detail
line. Descriptions for detail lines are limited to 254 characters.
HINT: Since all invoices and order forms support word wrap
on descriptions, you may optionally use multiple carriage
returns within a single description. If you have configured
Dimension to use Enter key as Tab, you may still add
carriage returns to a description by pressing Ctrl + Enter.
Expected Ship Date: Enter the date that you expect this detail line,
inventory item, sales, etc. to ship. If you do not know or wish not to enter
an expected ship date, the system will allow you to leave this field blank.
Quantity: Enter the quantity ordered for this detail line. The system will
default to the quantity on the sales code you used for the detail line.
Cost: Enter the individual unit cost for this detail line item. This
prompt is available only if the Master Data field Ask Unit Cost is
selected.
This field allows the system to track the total cost of sales in the
transaction files, which generate the sales reports and which you can post
to the General Ledger.
Price: Enter the individual unit price for this detail line item. If the
sales code used for this detail line item is defined with a default unit
price, the system will display that default unit price.
When the detail line item information is entered, click >Accept or F2 to
validate the detailed line item.

Description Only Lines (Type 0)
The system allows you to enter description only lines to the transaction. You
can use description only lines to add further information on the invoice and
orders about a line item entered or to print pre-defined description only lines.
To enter a description only detail line, enter a “0” for the Line Type.
The system will allow you to enter the following information:
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Code (1-9999): To select a pre-defined description only sales code, enter a
valid description only sales code number from 1 to 9999. To manually
enter a description only detail line, enter a Code of 0.
Description: If you selected a pre-defined sales code, the system will
display the description for that sales code and allow you to edit or add to
the description. If you selected Sales Code 0000, the system will prompt
you for the description to add to the invoice. You can enter up to a 254
character description.
Description Only Type: Offers enhanced flexibility for writing special
descriptions on your invoices.
Print All: Always print the description line.
Print Shipping Only: Print the description line on packing lists only.
Print House Only: Print the description line on in-house reports only.
Use As Subtotal Line: To add subtotals to the middle of an invoice, use a
zero description line set to Use as Subtotal Line. All the amounts
between this subtotal line and the subtotal line above it, or the beginning
of the invoice, will be added together and printed on this line with the
description given.
When the description only detail line item information is entered, click >
Accept or F2 to validate the detail line item.

Quick Inventory Lines (Type 2)
If you are using the CertiflexDimension Inventory package in conjunction
with Accounts Receivable, you have the option to enter Quick Inventory lines
in the transaction detail. The Quick Inventory line will use the default sales
code and location from the Inventory item and automatically fill in the
transaction detail.
To enter a Quick Inventory line, enter a “2” for the Line Type.
The system will prompt you for the following:
Quick Inventory Item: Enter the inventory item number that you wish to
use in the transaction. To bring up a list, press the F6 key or you may
scroll through a listing by using the up and down arrow keys. To toggle
the index for the inventory items, press your F5 key.
If the selected item is marked as a Master Item, the system will prompt
you for the individual serial/lot number being sold. For more information
regarding Master Items, please refer to Maintain Inventory Items in your
CertiflexDimension Inventory Operations Guide.
U/M: The default unit of measure for the inventory item is automatically
entered for you in this field. If the inventory item contains a unit of
measure which includes a conversion table with active alternatives, the
system will allow you to select the desired unit of measure.
Taxable: The system will show you if this sales code is taxable.
Discount Percentage: Enter this detail line's discount percentage. The
system will let you enter a percentage in this prompt only if the Master
Data field Discounts is set to Discounts Per Line.
Commission Percentage: Enter the correct commission percentage for
this detail line for the selected salesperson. The system will display this
prompt only if the field Ask Commission on the selected sales code and
the Master Data field Display Commissions are selected.
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Expected Ship Date: Enter the date that you expect this detail line,
inventory item, sales, etc. to ship. If you do not know or wish not to enter
an expected ship date, the system will allow you to leave this field blank.
Quantity: Enter the quantity of items for the order. The default quantity
will be automatically entered in this field for you, but you may change it
as necessary. The quantity may not be zero.
Cost: The system will only prompt you for this if the inventory item is a
Drop Shipment Item (Class 90-99).
Price: Enter the price of the item. The default price listed on the
inventory item, based on the customer Price Level (1-11) will be
automatically entered in this field for you, but you may change it as
necessary. If the customer has a price level of 11, the system will
calculate the desired selling price based on the quantity break available
on the selected item. You may optionally add a contract price to a specific
Item/Customer combination.
You may press F4 to display inventory prices for the item, or press F5 to
retrieve the last price for which this item was sold to this customer.
Also, you may choose to set up a custom inventory price matrix which will
apply to this customer. This can be set up in the CustItem.txt file, located
in the \CertiFLX\ADVX\XConnect subdirectory. This is a tab-delimited
file with each line using the following format:
Customer

#

Item #

Price

Expiration Date

When the detail line item information is entered, click Accept or F2 to
validate the detailed line item.

Inventory Lines (Type 3)
If you are using the CertiflexDimension Inventory package in conjunction
with Accounts Receivable, you have the option to enter Inventory lines in the
transaction detail. The Inventory line differs from the Quick Inventory line
in that you will have the option to modify more of the detail line.
To enter an Inventory line, enter a “3” for the Line Type.
The system will prompt you for the following:
Inventory Item: Enter the inventory item number that you wish to use in
the transaction. To bring up a list, press the F6 key or you may scroll
through a listing by using the up and down arrow keys. To toggle the
index for the inventory items, press your F5 key.
If the selected item is marked as a Master Item, the system will prompt you
for the individual serial/lot number being sold. For more information
regarding Master Items, please refer to Maintain Inventory Items in your
CertiflexDimension Inventory Operations Guide.
Location: Select the location of the Inventory items. The default location
will automatically be entered in this field, but it may be changed by using
the up and down arrow keys.
Sales Code: Enter the sales code that you wish to use for this
transaction detail line. The default sales code for the item will be entered
for you automatically, but you may change this by either typing in the
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code, pressing F6 for a listing or using the up and down arrow keys to
scroll through the list.
U/M: The default unit of measure for the inventory item is automatically
entered for you in this field. If the inventory item contains a unit of
measure which includes a conversion table with active alternatives, the
system will allow you to select the desired unit of measure.
Taxable: The system will show you if this sales code is taxable.
Discount Percentage: Enter this detail line's discount percentage. The
system will let you enter a percentage in this prompt only if the Master
Data field Discounts is set to Discounts Per Line.
Commission Percentage: Enter the correct commission percentage for
this detail line for the selected salesperson. The system will display this
prompt only if the field Ask Commission on the selected sales code and
the Master Data field Display Commissions are selected.
Expected Ship Date. Enter the date that you expect this detail line,
inventory item, sales, etc. to ship. If you do not know or wish not to enter
an expected ship date, the system will allow you to leave this field blank.
Quantity: Enter the quantity of items for the invoice. The default
quantity will be automatically entered in this field for you, but you may
change it as necessary. You may not enter a quantity of zero for an
inventory item.
Cost: The system will only prompt you for this if the inventory item is a
Drop Shipment Item (Class 90-99).
Price: Enter the price of the item. The default price listed on the
inventory item, based on the customer Price Level (1-11) will be
automatically entered in this field for you, but you may change it as
necessary. If the customer has a price level of 11, the system will
calculate the desired selling price based on the quantity break available
on the selected item. You may optionally add a contract price to a specific
Item/Customer combination.
You may press F4 to display inventory prices for the item, or press F5 to
retrieve the last price for which this item was sold to this customer.
You may also choose to set up a custom inventory price matrix which will
apply to this customer. For more information on setting up
customer/item matrix pricing, please refer to your CertiflexDimension
Inventory reference manual.
When the detail line item information is entered, click >Accept or F2 to
validate the detailed line item.

Inventory Kit Lines (Type 4)
If you are using the CertiflexDimension Inventory package in conjunction
with Accounts Receivable, you have the option to enter Inventory Kit lines in
the transaction detail as long as you have Inventory Kits set up in the
program. Inventory Kits allow you to group together items which are
typically sold together, such as sale items sold in packages, and allows you to
enter all detail lines in one step rather than entering each detail line on its
own. More information on setting up Inventory Kits can be found in the
CertiflexDimension Inventory Operations Guide.
To enter an Inventory Kit line, enter a “4” for the Line Type.
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The system will prompt you for the following:
Select Inventory Sales Kit: When you are on this field, a dialog box will
pop up that lists your available inventory kits. Enter the number of the
kit you wish to use, and select the Price Level you wish to use for the kit.
You will be able to then remove items from the kit if you wish by
unchecking the box next to the inventory item you wish to leave out of the
kit. Click the Ok button to accept the item.

Detail Listing and Transaction Totals
The Detail Listing and Transaction Totals will allow you to change existing
detail lines and add or change invoice items such as freight and discounts.

Editing Detail Lines
To change, delete or move an existing detail line, click on the Edit Detail
Options button or press F4. An Edit Detail Line Options screen with a listing
with all of your detail lines will appear.
Move Line: To change the order the detail lines, highlight a detail line
and click on the up or down arrow keys on the right side of the screen.
Delete Line: To delete a detail line, highlight the line or move to it with
the arrow keys and click Delete Line or press Alt+D.
Edit Line: To edit a field, double-click on the field you want to edit or
highlight the field and click Edit Line.
NOTE: Not all information entered on the detail line can be
edited. If you wish to edit a field that does not allow editing,
you must delete the complete line and add it again.
Remaining Credit
The system will display the customer's current credit balance. The system
calculates this amount by taking the difference between the total credit limit
defined on the customer's main record and the current outstanding balance
for the customer. If the customer’s remaining credit is negative, the number
will display in red. You can also see the customer’s account status. If the
customer is current, the background will be gray. If their oldest invoice is in
column two as described in the Master Data, the background will be green.
Aging in column three will be yellow and column four will be red.

Changing the Discount Percentage
If the Master Data field Discounts is set to Discounts on Subtotal, the system
will display the calculated discount amount in the transaction's subtotal
information. The system will calculate a discount amount based on the
discount percentage defined for the selected customer on the customer's main
record. If you want to change the discount percentage for the transaction
subtotal for this transaction only, click on the Discount button. The system
will prompt you for a new discount percentage and then recalculate the
discount amount and the transaction total.
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Please note that this discount amount is not related to the early pay discount.
If you defined early pay discount terms, the system will allow the early pay
discount in addition to the discount amount defined here. The discount
amount calculated on the invoice subtotal is used for quantity buying, sale
items, preferred customers, etc.
If the Master Data field Discounts is set to Discounts Per Line, the system will
not display a discount amount in the invoice's subtotal information section
and not allow you to select this option. The system will calculate a discount
amount on each line item entered and adjust the extended price and unit
price for the discounted amount. To change the discount amount on each line
item, you would adjust the discount percentage in the Discount % field located
between Taxable and Comm. %.

Changing the Retainage Information
If you are interactive with CertiflexDimension Job Cost program and the
retainage percent for the customer is not –1, the system will calculate the
retainage amount based on the retainage percent on the customer.
If you need to change the retainage percent on a customer, click on the
Retainage button to the left of the retainage amount. The system will
prompt you for the following:
Always Ask After Job: This option will prompt the user for a retainage
percentage after a job is entered. Once this option is selected, it will
remain checked for all invoices. If this option is not enabled, the
retainage percentage can be changed by clicking on the Retainage button
to the left of the retainage amount.
Retainage Percentage: Enter the new retainage percent for this invoice.
This change is only for this invoice. To change the retainage for a
customer, go to Maintain Customers.
Retainage Reference Number: If a retainage percentage was entered
above, enter the reference number to use for the retainage.
Retainage Due Date: If a retainage percentage was entered above, enter
the due date for the retainage amount.

Changing the Tax Information
The system will calculate a tax amount based on the tax status and tax rate
defined for the customer on the customer's main record and on the taxable
status of the sales codes used for this transaction. The tax amount is
displayed in the transaction's subtotal information. If you need to change the
tax status, tax rate, or to add additional tax amounts to the calculated tax,
either click on the Tax button to the left of the tax amount or press Alt+T.
The system will prompt you for the following:
Taxable Status: Select Taxable if the entire transaction is to be taxed. If
the entire transaction is tax exempt, select Non-Taxable.
NOTE: If the transaction needs to have a mix of taxable and
non-taxable detail line items, the tax status for each detail
line item is controlled by the sales code used.
Tax Rate: Select the correct tax rate for this transaction.
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Additional Tax: If you want any additional tax amounts added to this
transaction, enter that tax amount here.
When the tax information is saved, the system will recalculate the tax
amount and the transaction total.
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Changing the Freight Amount
The system will allow you to enter a freight amount for this transaction. The
freight amount is displayed in the transaction's subtotal information. If you
need to add or change the freight amount, click on the Freight button to the
left of the freight amount or press Alt+F. The system will prompt you for the
freight amount. The system will recalculate the freight amount and the
transaction total. If all transactions to be written during this session have
the same freight amount, check the Save As Default box. The next transaction
will have the same freight amount as the previous transaction. Default
freight amounts are saved per session and will be reset to zero at the start of
a new session.

Changing the Payment Amount
If the customer is a cash customer, or you are entering a cash invoice, the
system assumes that payment was made in full and that it was made by the
selected default payment type. If you need to change the payment amount,
click on the Payment button to the left of the payment amount or press Alt+P.
The system will prompt you for the following:
Payment Type: Select how the payment was made. You can choose from
one of seven defaults: American Express, Master Card, VISA, other
credit card, EFT, cash, or check.
Check/CC Number: Enter the check or credit card number used for the
payment if applicable.
Payment Amount: The payment amount will always show as payment in
full. If the customer is making a partial payment or overpayment, check
the box labeled Allow Partial and/or Overpayment. Then enter the
payment amount.
Payment Description: This field will default to the word “Payment – “
and the Payment Type. You may key in any payment description.
Authorization Code: If this is a credit card payment, enter the
authorization code if you choose.
Overpayment Description: Enter the description you want to see in the
customer’s history for any overpayment. You can only have an
overpayment if you checked the Allow Partial and/or Overpayments.
Print Terms: Enter the print terms you want to print on the invoice. The
system will default to “Prepaid – “ with either the check number or the
last four digits of the credit card number if entered.

Preview the Sales Order
The system will allow you to preview the sales order you are currently
writing prior to updating and printing. If you would like to preview the
current sales order, either click the Print Preview button at the bottom left of
the screen or press F3. It will show you a preview of what the sales order will
look like when it is saved and printed.

Saving the Sales Order
When all detail line items are entered, click >Save to print the sales order to
the selected printer and save the transaction. Once you have saved a
transaction, you will be returned to the Select Customer & Start Transaction
window and allowed to enter your next sales order.
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Record Customer Quotes
This option allows you to enter a sales order as a quote to a prospective
buyer. When you enter a quote, the system will save the quote separately
from the regular order entry sales orders. If the quote is accepted, you can
optionally transfer the quote directly to the order enter files, eliminating the
need to enter a sales order. If the quote is not accepted, you can change or
delete the quote from the quote files.
To record a customer quote, click >Transactions >Order Entry >Record
Customer Quotes.

The Record Customer Quote program operates identically as Record
Customer Orders. Therefore, for a complete description of all options for
Record Customer Quotes, refer to the Recording an Order section.
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Transfer Quotes to Orders
This option allows you to automatically move an entered quote into the order
entry data files. This eliminates the need to re-enter a sales order for an
accepted quote.
To transfer a quote to an order, click >Transactions >Order Entry >Transfer
Quotes to Orders.

To transfer a quote to an order, select the quote to transfer from the sales
quotes listing and click Transfer Selected Quote to Order System.
Once a quote is transferred to the order system, the system will not allow you
to access the quote from Record Customer Quotes. The system deletes the
quote after the transfer is complete. If you need to make changes to the
transferred quote, access the transferred quote through Record Customer
Quotes.
NOTE: To transfer a quote from an Archived Quote file, select
the archived file from the Quote File list.
When you transfer a quote and the customer of the quote has a Class of 98 (a
special Accounts Receivable customer), the system will prompt you to add a
new customer. Doing so will add a new customer to the database and retrieve
the customer address fields defined on the quote.
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Order Entry Imports
The CertiflexDimension Order Entry Imports program allows you to import
Orders, Quotes, and Shipment Tracking Numbers. To access this option,
click >Transactions >Order Entry >Order Entry Imports.

Import Orders
Use this option to import Sales Order transactions from an ASCII Tab
Delimited file created by third-party software into your CertiflexDimension
Order Entry system.

Please refer to the following documentation file for detailed information on
importing transactions into CertiflexDimension:
...\CertiFLX\Advx\CDmn\DOC\ImportTrn.rtf
All transaction import systems must be configured prior to implementation.
To access the Configure Transaction Imports program, from the
CertiflexDimension System Manager screen, click >File >Supervisor Options
>Configure Transaction Imports.
Once you have configured your import system, click >Access Now to
continue.
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Import Quotes
Use this option to import Quotes from an ASCII Tab Delimited file created by thirdparty software into your CertiflexDimension Order Entry system.

Please refer to the following documentation file for detailed information on
importing transactions into CertiflexDimension:
...\CertiFLX\Advx\CDmn\DOC\ImportTrn.rtf
All transaction import systems must be configured prior to implementation.
To access the Configure Transaction Imports program, from the
CertiflexDimension System Manager screen, click >File >Supervisor Options
>Configure Transaction Imports
Once you have configured your import system, click >Access Now to
continue.
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Import Shipment Tracking Numbers
Use this option to import Shipment Tracking Numbers from an ASCII Tab
Delimited file created by third-party software into your CertiflexDimension
Order Entry system.

Click >Access Now to continue.

NOTE: If you are importing shipment tracking numbers into
orders prior to invoicing, select the option Open Orders –
Import Before Invoicing. If you are importing shipment
tracking numbers into orders after the orders have been
invoiced, select the option Closed Orders – Import after
Invoicing.
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Follow the on-screen instructions to import your third-party, tab-delimited
ASCII file.
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Calculate Quantities to Ship
You choose to use this option only if you are operating interactively with the
CertiflexDimension Inventory program. The purpose of this program is to
access the inventory files to determine the status of stock availability for
outstanding order lines.
You are not required to process this option. The system will allow you to print
packing lists and record shipments without calculating the quantities to ship.
However, you may prefer to use this option. Read the following explanations
to determine which method is best for the company’s needs.

Calculating Quantities Available to Ship
When you calculate quantities available to ship, the system allocates
inventory to the oldest orders first and then to more recent orders until the
particular inventory stock item available is depleted or all orders are filled.
Using this method assures that orders are filled on a first come, first served
basis. When packing lists are printed, only order lines with a quantity
available, even if the quantity available is less than the quantity ordered, are
included. Any order line for which there is no quantity available is excluded
from printing on the packing lists.
The main advantage of this method is, in theory; all packing lists are 100%
filled, since the packing lists consider on-hand stock quantities and backorder
quantities. This means that the oldest orders are always completely filled
prior to considering more recent orders for partial shipments. Warehouse
personnel will know in advance how many units they should expect to find for
each stock item listed on the packing list. The quantity shipped that they
write on the packing lists should always agree with the quantity available
under this method.
There are two disadvantages to using this method, however. First, it can take
a considerable amount of time to perform the calculation of quantities
available to ship if the order processing volume or inventory item file is large.
Secondly, if the inventory on-hand quantities are often unreliable, then stock
which is actually in the warehouse but not shown as on-hand in the inventory
system will not appear on the packing lists. Therefore, the item will not be
shipped or billed. In addition, if unreliable inventory on-hand quantities
result in a calculation of quantities available to ship when there is really no
stock in the warehouse, this can cause warehouse personnel wasted time
searching for stock that is not there.

Not Calculating Quantities Available to Ship
This method allows you greater flexibility in processing the orders. Orders
may or may not be shipped in the order in which they were received. Because
packing lists will always show the quantity ordered less any prior shipments,
you can ship the orders in any manner that you choose.
The main advantage of this method is the order processing is faster and may
result in fewer errors. This method is best suited for you if you rarely run out
of inventory stock items or if the inventory records often reflect incorrect
quantities due to an unstable or fast changing inventory.
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The disadvantages of this method are backorders are not automatically
shipped ahead of new orders and warehouse personnel will not know in
advance whether there is stock on-hand to fill an order.

Choosing to Calculate Quantities Available to Ship
Whether you choose to calculate quantities available to ship or not, the
packing lists will appear the same under either method. The only difference
between the two methods is how to handle a situation where orders are
greater than the current inventory level.
If you choose to calculate quantities available to ship, the system will read
through each open order in the Order Entry program and compare the
ordered inventory items with the inventory items in stock. The system will
also re-update each inventory item’s backorder amount if needed. This means
that if you add, change, or delete orders and then execute this option, the
system will automatically re-update the backorder amount of each inventory
item as needed. This ensures that the inventory backorder amounts reflect
true backorder quantities.
To calculate quantities available to ship, click >Transactions >Order Entry
>Calculate Quantities to Ship.

The system will prompt you for the beginning and ending inventory items to
calculate a quantity available to ship for. When an inventory item range is
selected, click >Calculate to begin the process.
Remember that the amount of time this process will take will depend on the
number of open orders and the number of inventory items on file.
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Record Shipments
This option allows you to enter the quantity for each packing list line that
was actually shipped. When the warehouse personnel pulls stock items for
shipping, per the packing lists, the personnel should mark on each packing
list line the quantity of the items ordered that they pulled for shipment.
When they have finished pulling an order, the personnel should return the
packing lists to you so you can use that information to record the shipments.
If you are operating interactively with the CertiflexDimension Inventory
program, the system will relieve the inventory items from Inventory when
you process the Record Shipments option.
To record shipments, click >Transactions >Order Entry >Record Shipments.

Recording Shipments
Order No.: Enter the order number to record shipments for, or select the
order from the Open Order Listing by clicking on the spyglass , and then
click >Start.
Attachment
: Click here to record an additional transaction
attachment o the shipment. Right-clicking on this button will release a
drop-down menu allowing you to Add a new attachment or View, Edit,
and Delete an existing attachment.
Shipping and Handling Charge: Enter or change the previously entered
freight amount for this order.
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[F4] Ship Complete: If the entire order was shipped complete, you can
click this button to cause the system to automatically mark this entire
order as shipped.
If the order is not shipped complete, you will need to record shipments on
a line by line basis for both detail line items and for description only
lines.
To record shipments for a detail line item, double-click on the individual
line item. The system will prompt you for the quantity shipped. Enter the
amount and click >Ok. Continue until all shipped line items have been
recorded.
NOTE: You can quickly ship an individual line for its full
quantity by selecting a line and clicking [F2]. If you have a
large shipment with 20 of the 21 lines shipped complete, use
the [F4] Key to complete all lines and then select the singe
line that did not ship and click [F2]. The program will
automatically unship the individual selected line.
We do not recommend that you enter a quantity shipped that
is greater than the quantity needed. If you actually shipped
more of an item than was originally entered on the order, you
should change the quantity for the line item to the correct
amount through Record Customer Orders. If you do record
shipments for a detail line for an amount greater than the
quantity needed and you are interactive with the
CertiflexDimension Inventory program; the system will
update the inventory item’s backorder amount by a negative
amount. This will cause the inventory item’s backorder
amount to not reflect true backorder amounts.
[F5] Carrier/Cartons: If you are tracking carriers per shipment, tracking
shipment numbers, or number of cartons for this order, click this option
and the following screen will appear.

o

Carrier: Select the carrier for this order. You can use the arrow keys
to scroll through your list of active carriers.

o

Shipping Method: Select a shipping method for your selected carrier.

o

Number of Cartons: Enter the number of cartons being shipped.

o

Shipment Weight: Enter the weight of the current shipment.

o

Freight Cost: Enter the amount paid for this shipment. This is not
necessarily the same amount you are billing your customer for
shipping and handling. This is the amount that you expect to be
billed from the carrier for this shipment.
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o

Shipment Tracking Number: Enter the shipment tracking number for
the shipment, if available. Tracking numbers may be printed on
carton labels and emailed as shipping confirmations.
NOTE: This additional shipping information is stored on each
order and updated to the completed order system upon
invoice. Entering multiple shipments on an individual order
without invoicing each shipment will cause the system to save
only the additional shipment information last recorded. The
system will display a reminder message if you attempt to
record additional shipments for an order that has already
been shipped but not invoiced.

Print Carton Labels: Select this option if you wish to print carton labels
for the current shipment.

o

Printer Setup: Select this option to change the printer used for carton
labels.

o

Report View: Select this option if you wish to print labels to report
view in lieu of to your printer.

o

No of Labels: Select the number of labels you wish to print for each
carton.

o

Note 1 – 2: Enter any additional notes you wish to include on the
carton labels.

o

Starting Label: Enter the starting label to use for the current label

o

Carton Wording: Define the descriptive wording for the label. You
can choose Box, Carton, Package, or Pallet.
NOTE: The system ships with carton labels predefined to use
a Avery Style 5164. This can be changed to other popular
formats. For assistance in changing the label format, please
contact Technical Services.

The system handles the recording of shipments for Description Only lines a
little differently. Until it is recorded as shipped, even partially, you can never
print a description only line on invoices generated for shipped orders.
Description only lines are often used to extend the description for a particular
order line. Therefore, you need a way to control when the description only
lines will print on the invoices generated for the order when the order line is
recorded as shipped. In the event that the order line with which a description
only line belongs to is partially shipped, you also need to be able to control
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whether the description only line will appear only on the first invoice
generated or on subsequent invoices generated for the order.
When you double-click on a description only line, the system will prompt you
for the following:

Show Description Line on Invoice and Keep for Future Printing: Select
this option if you want the description only line to print on the customer’s
invoice and you also want the system to retain the description only line
for future invoice printing if this order is not shipped complete.
Show Description Line on Invoice and Delete from Future Printing:
Select this option if you want the description only line to print on the
customer’s invoice and you do not want the system to retain the
description only line for future invoice printing.
Do NOT show Description Line on Invoice: Select this option if you do
not want the system to print the description only line on the customer’s
invoice.

Options
Zero Dollar Order Warning: Select this option if you want the system to warn
you if the selected order to ship has no billing value.
Show Lines: Use this option to determine what detail lines will appear on
orders to be shipped.
o

All: You should always use this option when you are recording
shipments when you are not using the Calculate Quantities to Ship
option. The system will always default to this selection.

o

Backorder Only: You should use this option to record shipments
when you are not using the Calculate Quantities to Ship option and
you want the system to access only order lines that have not already
been completely shipped. This means the system will only access
order lines for shipments that have a quantity on backorder.

o

Available Only: You should use this option if you used the Calculate
Quantities to Ship option. This method allows you to print packing
lists that will only contain order lines with a quantity available to
ship. If the inventory records are correct, this means that each
packing list is filled 100% because the quantity on the packing list
will be the quantity that is available according to the system. Then,
when shipments are entered through this option, you should
theoretically be able to simply validate each order accessed as
shipped complete.
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Email Packing List Options: Use this option to select an emailed packing
slip be sent for this order.
Print/Update Options: Use these options to determine if you wish to print
packing lists or print and update invoices as you save each shipment.
o

Print Packing List: Check this box if you wish to print a packing list
as you save each shipment. The packing list will only contain items
that have been shipped during this session.

o

Forms: Select this option to define the packing list’s form and printer
destination. For more information on these settings, please refer to
the Record Customer Orders >Settings: Forms and Printers section
of this guide.
HINT: You can select your packing list form or change your
printer selection for a packing list by clicking the forms
button to the left of the packing list option.

o

Print/Update Invoice – Check this box if you wish to immediately
print and update an invoice as you save each shipment. This is the
same as if you had recorded a shipment, exited the record shipment
program, immediately went to the option to Record Invoices on
Shipped Orders and selected the order you just shipped as the
beginning and ending order to invoice.

o

Forms: Select this option to define the invoice’s form and printer
destination. For more information on these settings, please refer to
the Record Customer Orders >Settings: Forms and Printers section
of this guide.

o

Prompt for Printing Output: Check this box if you want the system to
prompt you to define the invoice form’s printer/output destination
once the Record Shipment has been saved. If this option is enabled,
the following screen will be displayed:



Current Form: This section displays the current form. To use a
different form or select a printer other than your default, click the
Forms & Printer button.
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NOTE: To use the default form output as defined in the
customer’s Invoice form setting’s, select Calculate (By
Customer/Output).


Style – By Customer: Select this option to use an output style as
defined on the customer. For example some customer may be marked as
“Email” and “Printer” while other customers may have no output marked
“Post Only”.



Style – None: Select this option to update all invoices without any
output “Post Only”.



Style – As Selected: Select this option to output all forms in the
selected modes of Printer, Email, Fax or Other. For example, to print and
email an invoice for every transaction, use “As Selected” and then check
“To Printer” and “To Email” and uncheck “To Fax” and “To Other”.
NOTE: All forms printing to printer may be redirected to the
Print Preview System by selecting Preview Screen. Email
forms may include confirmation only (no attached PDF) by
selecting Confirmation Only. For more information on
specific form output styles, please refer to Accounts
Receivable >Maintain Customer - Invoice Form Output.

Click >Ok to output and update your selections.
Review Shipping Log: Click this button to review the shipments recorded
during the current session. This will be the report the system will allow
you to optionally print when you exit from this program.
When the selected order is shipped complete or shipped in accordance with
the packing list notations, click >Save to save the record shipment entries.
If the selected order included serial numbered master inventory items, the
system will prompt you to enter the serial number portion of the stock
number for the actual serial numbered item shipped.
Once the shipment has updated all additional reports and order options, you
can select the next order you wish to ship. Once all orders have been shipped
and you exit the Record Shipment program, a shipping log and a detailed
transaction log for invoiced orders can be printed.
NOTE: Shipped orders that are also invoiced are recorded to
the ‘Closed Order’ system. Orders that are fully shipped and
invoiced are deleted from the ‘Open Order System’. Partial
shipped and invoiced order’s remaining lines are assigned a
new order number with a suffix starting at .01 up to .99.
Example : If you partially ship and invoice Order Number
1209-020, the remaining unshipped lines will be assigned a
new order number of 1209-020.01.
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Invoice Shipped Orders
This option allows you to generate automatic billing of shipped order lines.
All the system requires you to do is to select the range of orders to invoice
and the system will generate the invoices automatically and update the
Accounts Receivable files.
NOTE: To invoice orders added in the Order Entry program,
you should always use this option. You should never generate
invoices for orders through Record Invoices in the Accounts
Receivable program. If you invoiced an order through the
Accounts Receivable program, the system will not
automatically generate the invoice and mark the order as
being invoiced. Therefore, the order would continue to remain
as an active order. If you invoiced an order through the
Accounts Receivable program and through the Order Entry
program, the customer will have duplicate open items on their
record.
This option allows you to automatically generate invoices for all shipped
order lines since the last billing cycle. The invoices generated from this option
will post to the Accounts Receivable data files. For this reason, it is very
important that you have the system date set to the most current processing
period for the company. You should also generate invoices from this option
each period before starting new period files. If you do not generate the
invoices for shipped orders before starting new period files, the system may
record the sales to the wrong period.
If you are operating interactively with the CertiflexDimension Inventory
program, when you execute this option, the system will not update the
Inventory data files. The system already updated the Inventory data files
when you executed the option to record shipments.
Remember that the system will only generate invoices for order lines that
have been recorded as having a quantity shipped from the Record Shipments
option.
To invoice shipped orders, click >Transactions >Order Entry >Invoice
Shipped Orders.
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The system will prompt you for the following:

Orders to Invoice
Range of Records: Enter the beginning (From) and ending (To) orders to
invoice.
Selected Records: Select this option if you wish to only process certain
orders. Once you’ve selected this option, click >Select Records and a
listing of shipped orders will be displayed. Double-click on the orders you
want to invoice. Selected orders will highlight and be marked with a
bullet • to the left of the Order Number. Once you have selected all
desired orders, click >OK.
Ask Reprint Invoices Prior to Posting: Check this box if you want the
system to prompt you to reprint invoices prior to posting.
Change Forms & Printer
o

Selected Form: This section displays the currently selected form. To
print a different format, click on the down arrow and select the
desired form.

o

Selected Printer: This section displays the printer currently selected
to print. To use a different printer, click >Printer Setup…

o

Printer Output: Select the check box that corresponds with your
preferred method of output, either Selected Printer or Preview
Screen.

o

Copies: Enter the number of copies you want printed.

After all selected invoices have printed and been updated to Accounts
Receivable, the system will update the Order Entry System with the orders
invoiced. A brief recap of Order Entry updates is as follows:
Step 1: Update Completed Order File – A copy of the invoiced portion of
the order is placed in the Completed Order File.
Step 2: If the order has no remaining backorders the remaining order is
deleted from the Open Order File.
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Step 3: If the Order has remaining backorders and you have elected to
auto-delete backorders for this order, the remaining order is deleted from
the Open Order File and the remaining backorders are tracked in the
Discarded Backorder File.
Step 4: If the Order has remaining backorders and you have NOT
selected to auto-delete backorders for this order, the completed lines will
be deleted and the remaining Backorders lines will be moved to the Open
Order File. The actual order number will now include a sequence number
at the end. For example Order Number 0812-2001 would become 08122001.01 indicating that this order is the remaining portion of original
order 0812-2001.
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Reviews – Order Entry

Review Orders
Reviewing orders allows you the ability to look up and review information
about an order without accessing the order through the Transactions
screens. When you need to verify information for an order, you would use the
Review option instead of the Transactions option.

Reviewing a Sales Order
To review an order, click >Review >Order Entry >Review Orders.

NOTE: You may also access review orders within the
Accounts Receivable >Review Customers program. From
the Customer Account Detail screen, under Additional
Options, click >Sales Orders. Select from Open Orders,
Closed Orders - Last Six Months, or Closed Orders - Last
Two Years and click >Ok. A window will open displaying the
orders selected. Double-clicking on an individual order will
open the Review Order Entry screen.
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From the Review Order Entry screen, you may perform the following
functions:
Type of Orders: The review order system tracks three separate order files. To review
current orders that have yet to be complete, select “Open Orders”. To review orders that
have been complete (shipped and invoices), select “Closed Orders”. To review open
quotes that have not been transferred to orders, select “Open Quotes”.
Search: Enter a character string for the order record you are searching for. The
character search string you enter depends on how you have the Sort By list option
defined.
List Options –

Sort By: Select the column you wish to sort your order listing by.

List Options –
Locate: To refine your order record search, you can locate matches by
using the standard CertiflexDimension Locate dialog. For more information on this
feature, please refer to the section labeled “Using the CertiflexDimension Locate Dialog.”
List Options –
Filter: Using the standard CertiflexDimension Filter dialog, you can
filter any listing so that only matching records appear (i.e. Show only vendors that
contain the word “Acme” in their account name). For more information on this feature,
please refer to the section labeled “Using the CertiflexDimension Filter Dialog.”
Views: This dropdown menu provides an assortment of order overviews. Each View
screen will have a Search field located in the upper left corner and an Options button
located in the upper right corner that allows you to apply the standard Sort By, Locate,
Filter, and Details (Drill Down) functions to the current data.

Open Order Summary: An order
recap of all open orders.
Open Order Detail: An order
listing of open order detail lines.
Closed Order Summary: An order
recap of all closed orders.
Closed Order Detail: An order
listing of closed order detail lines.
NOTE: Since “Alternate Account Views” contain report totals,
these options are only available to user having security access to
both the “Review” and “Report” options per accounting system.
Quick Print Billing and Shipping Labels
: Allows you to print a user
defined context label for the current account to a specific label printer.
For more detail information on configuring and/or changing Quick Labels
for Vendors, Customer, Items and Orders, please refer to your
CertiflexDimension System Manager Guide – Quick Print Labels.
Create New MyNote
: Allows you to record and attach a MyNote that
will be associated with the selected order. All of your MyNotes can be
accessed from the main CertiflexDimension System Manager window.
For more information on how to get the most out of your MyNotes
system, please refer to the MyNotes overview in your CertiflexDimension
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System Manager Guide.
Email Order Contact
: Allows you to create new email message to the
contact associated with the selected order.
To review a specific order’s detail, select and order from the listing and click
>Drill-Down or simply double-click on the desired order. The Order Detail
screen will appear.

From the Order Detail screen, you may perform the following functions by
clicking on their corresponding icons:
Attachment : Right-click on the paperclip icon to either View, Add, Edit
or Delete an attachment for the selected order.
Create New MyNote
: Allows you to record and attach a MyNote that
will be associated with the selected order. All of your MyNotes can be
accessed from the main CertiflexDimension System Manager window.
For more information on how to get the most out of your MyNotes
system, please refer to the MyNotes overview in your CertiflexDimension
System Manager Guide.
View Combined Order Detail Lines
: Allows you to review detail lines
for combined, partially shipped, orders.
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Reports - Order Entry
Order Entry Reports
Printing reports in CertiflexDimension for Windows is an easy, yet powerful
portion of the program. You can define the system to print almost any report
based on almost any criteria you desire.
To print a standard report in Order Entry, click >Reports >Order Entry
>Standard Order Entry Reports.

Click >Options to define the reporting criteria.
Refer to your CertiflexDimension System Manager Guide for an explanation
of each field on the Print Reports & Graphs screen and how to use the
Sort/Selects feature.
Below is a list of Order Entry reports and the printing options available for
each report.
NOTE: The Sales Orders, Sales Quotes, and Packing Lists do
not use the standard report printing options. These reports
are explained separately at the end of this chapter.
The Shipping Logs and Invoices are explained in the
Transaction section.
The following reports are printed in similar format:
Open Orders By Order Number
Open Orders By Customer Number
Open Orders By Expected Ship Date
Open Orders By Sales Code
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Open Orders By Inventory Item (With CertiflexDimension Inventory)
Open Orders By Job Number (With CertiflexDimension Job Cost)
Completed Orders By Order Number
Completed Orders By Customer Number
Completed Orders By Sales Code
Completed Orders By Inventory Item (With CertiflexDimension
Inventory)
Discarded Orders By Order Number
Discarded Orders By Customer Number
Discarded Orders By Sales Code
Discarded Orders By Inventory Item (With CertiflexDimension
Inventory)
Quotes By Quote Number
Quotes By Customer Number
Quotes By Sales Code
Quotes By Inventory Item (With CertiflexDimension Inventory)
The can print these order reports in either a summarized or detailed format.
Each Open Order report also includes an Anticipated Shipment Schedule.
This report reflects the dollar value of anticipated shipments aged by
requested ship date, and provides anticipated cash receipts.
It is recommended that you print and review the Open Order reports
periodically to ensure that there are no canceled orders remaining in the
system. These reports also serve to assist you in making decisions regarding
inventory stock levels.
Below is an explanation of most of the column headings that appear on these
reports.
Quantity Ordered: This quantity represents the original quantity ordered
when the order was entered.
Quantity Available to Ship: This quantity represents the available
inventory stock allocated to this order by the execution of the Calculate
Quantity Available to Ship option. If you are not operating interactively
with the CertiflexDimension Inventory program, this column will always
show 0.00 for each line on the report.
Backlog Quantity: This quantity is the difference between the original
quantity ordered and the total quantity shipped.
NOTE: The system will not display the quantity shipped on
these reports.
Quantity Unbilled: This quantity represents the quantity for the order
that has been shipped but no yet billed (invoiced).
Requested Ship Date: This date represents the expected ship date that
was entered when the order was added. The system will only display this
column on the detailed reports. For description only detail lines and for
order lines that did not have an expected ship date entered, the system
will leave this field blank.
Backlog Value: This backlog value is calculated as the backlog quantity
times the unit price less any discount amounts that are applicable.
At the end of each Open Order report, the system will print the Anticipated
Shipment Schedule report. This report provides an aging of shipment values
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and anticipated cash receipts based on the sales orders included on the
selected backlog report.
These schedules show the total backlog value, broken into four future aging
categories. The first category is pre-set to Current. The system allows you to
define the remaining three categories in the Accounts Receivable Master
Data on the Order Entry tab. The system comes with default aging categories
of 31 to 60, 61 to 90, and Over 90.
Anticipated Shipments: This schedule shows the anticipated dollar value
of upcoming shipments, based on the requested ship dates for all order
lines included in the selected report.
Anticipated Cash Receipts: This schedule shows the anticipated dollar
value of cash receipts, based on the requested ship dates for all order
lines included in the selected report and the billing terms for each order
included.
NOTE: The system will use the current processing date used
to print the Open Order report in the calculation of the
anticipated shipment schedules reports for order lines which
do not have an expected ship date set. The system will also
use the current processing dates for order lines that have an
expected ship date that is an earlier date then the processing
date.

Reports by Order Number, by Customer, by Item, by Job Number Options
Print Detail: Select this option if you wish to print detailed line items.
Print Item Number: Select this check box if you want the system to
include the inventory item number for each detail line on the backlog
report.
NOTE: This prompt is used when you are printing a detailed
backlog report that includes inventory item detail lines. If you
are printing a detailed backlog report that does not include
any inventory item detail lines or a summarized backlog
report, the system will ignore this selection.
Range of Inventory Locations to Include: Select the range of inventory
locations you wish to include for inventory items if you are operating
interactive with CertiflexDimension Inventory.

Reports by Expected Ship Date Options
Print Detail: Select this option if you wish to print detailed line items.
Print Item Number: Select this check box if you want the system to
include the inventory item number for each detail line on the backlog
report.
NOTE: This prompt is used when you are printing a detailed backlog
report that includes inventory item detail lines. If you are printing a
detailed backlog report that does not include any inventory item
detail lines or a summarized backlog report, the system will ignore
this selection.
Date Range: Enter the beginning and ending dates to report for.
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Range of Inventory Locations to Include: Select the range of inventory
locations you wish to include for inventory items if you are operating
interactive with CertiflexDimension Inventory.

Shipping Labels
Shipping Labels prints labels for open Orders. The system will allow you to
specify the number of labels to print for each order and whether to print the
customer’s billing address or shipping address.

Report Criteria
Print Shipping Address: Select this check box if you want the system to
print the customer’s shipping address on the shipping labels. If you do
not select this check box, the system will print the customer’s billing
address.
Avery Label Brand: Select the type of label to print.

Carrier Report
Carrier reports print all shipped orders for a specified date range by selected
carriers. Included in the detailed reports are a listing of each shipment
including date, weight, freight cost and billing. The carrier report should
simplify freight company statement reconciliations and insure you are paying
for authorized transactions only.

Report Criteria
Detailed Report: Select this option if you want to see a detail of each
shipment.
Carrier List: Select the carriers you wish to include on the report. Only
carriers you select will be printed.
Date Range: Enter the beginning and ending dates to be included in the
report.
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Printing Sales Orders and Quotes
The Sales Order report will list all open orders. The Sales Quote report, much
like the Sales Order report, will list all open quotes. The system will allow
you to print these reports as often as needed and on any schedule that you
desire. We recommend that you print all new orders and quotes when entered
or at the end of each day. You should also reprint any order or quote that you
have changed.
To print Sales Orders or Sales Quotes, >Reports >Order Entry, and then click
Sales Orders or Sales Quotes.

Orders to Print
Range of Records: Enter the beginning (From) and ending (To)
orders/quotes to print.
Selected Records: Select this option if you wish to only process certain
orders/quotes. Once you’ve selected this option, click >Select Records
and a listing of orders/quotes will be displayed. Double-click on the
orders you want to print. Selected orders/quotes will highlight and be
marked with a bullet • to the left of the Order Number. Once you have
selected all desired orders/quotes, click >OK.
Include House Descriptions: Select this option if you want the report to
print any house descriptions that may have been added to the sales order
or quotes.
Order Type: Select whether you wish to print open or closed orders (Print
Sales Orders only).
Selected Form: This section displays the form currently selected to
picking or packing list.
Selected Printer: This section displays the printer currently selected to
print.
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Once you have defined your order/quote print settings, click >Print Orders or
>Print Quotes.
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Printing Packing Lists
The Packing Lists print the actual lists that you can give to the warehouse
personnel to fill orders. You can also include the packing lists in the shipped
orders. The system will allow you to print the packing lists in a variety of
different ways. There are actually two different styles available for packing
lists. The first style is called a Pick List. A Pick List is designed to be printed
for orders not shipped and not invoiced. A Pick List includes a blank column
for warehouse personnel to complete with the quantity shipped. The second
style is called a Packing List. A Packing List is designed to be included with
the shipped product and only includes orders shipped but not invoiced.
To print the Packing Lists, click >Reports>Order Entry >Print Packing Lists.

Form Style and Options: Select the form style you wish to use: Picking
List (Before Shipments) or Packing List (After Shipments).
Include Standard Description Lines: Select this check box if you want the
system to include any normal description only lines on the forms. If you
do not want description only lines included on the forms, do not select
this check box.
Include Shipping Description Lines: Select this check box if you want the
system to print any Shipping descriptions on the selected forms.
Picking List Only Options:
o

Include House Description Lines: Select this check box if you want
the system to print any House descriptions on the pick lists.

o

Include Only Lines with Available Stock: Select this check box if you
performed the option Calculate Quantities to Ship prior to selecting
this option. If you select this check box, the pick lists will only include
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order lines with a quantity available to ship greater than zero. Any
other order lines will not be included.
If you select this check box, the system will base the pick lists on the
information the system obtained the last time you calculated
quantities available to ship. If you did not calculate quantities
available to ship immediately prior to selecting this option, the
picking lists will probably include incorrect information.
Detail Line Item Order: Select the order in which you wish to print the
pick list detail lines. You may select from Line Entry, Bin Number or
Expected Ship Date.

Orders to Print
Range of Orders: Enter the beginning (From) and ending (To) orders to
print.
Selected Records: Select this option if you wish to only process certain
orders. Once you’ve selected this option, click >Select Records and a
listing of available orders will be displayed. Double-click on the orders
you want to print. Selected orders will highlight and be marked with a
bullet • to the left of the Order Number. Once you have selected all
desired orders, click >OK.
Selected Form: This section displays the form currently selected to
picking or packing list.
Selected Printer: This section displays the printer currently selected to
print.
Once you have defined your picking/packing list’s print settings, click >Print
Orders.
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Order Entry WorkSheet Reports
Using WorkSheet Reports in CertiflexDimension is an easy, yet
powerful portion of the program. You can use this system to
create almost any interactive WorkSheet you desire.
To use an Order Entry WorkSheet Report, click >Reports >Order
Entry >WorkSheet Reports.
The system will display a WorkSheet Listing for your selected
module. Select the WorkSheet you wish to use and click >
Create.
NOTE: Each WorkSheet can be saved in three different
styles. The system will always start with the “Default” style
saved for this WorkSheet.

The options for formatting and printing WorkSheets are the
same in all systems. For detailed information about each of
these specific functions, please refer to your CertiflexDimension
System Manager Guide – WorkSheet Reports.
WorkSheets
Below is a list of WorkSheet Reports available for this module.
Open Order Summary
Open Order Detail
Closed Order Summary - MTD
Closed Order Summary - YTD
Closed Order Detail - MTD
Closed Order Detail - YTD
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Compressing Data Files

Compress Order Entry Files
Compressing the Order Entry Files for Completed Orders, Discarded Orders
and Quotes allows you to have the system remove old data from the system's
data files. You would periodically select this option to remove old transaction
information that you no longer need or want in the data files.
We recommend that you perform this option as part of the year-end
processing procedure. For example, if the company needs to have the last two
years of transaction information on file, at the beginning of each year, you
would compress the unneeded year.
To compress the customer history information, click >File >Data File
Maintenance >Compress Data Files. The Compress History Wizard screen
will be displayed. Click >Next to continue.

File List: Select the data file to compress. For Completed Orders (Closed),
select OEC – Closed Customer Orders. For Discarded Orders (Deleted),
select OED – Deleted Customer Orders. For Quotes, select OE2 –
Customer Quotes. Click >Next to proceed.
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Compression Type: This selection allows you to define how many years
of history transactions to remove from the customer's files.
NOTE: Many CertiflexDimension reports generate their
information from the detail files. Be careful of the selection
here for the compress to date. If you compress history
transactions and then later attempt to print a report that
generates its information from the history files for a date that
has been compressed, the system will not be able to retrieve
the information without restoring a backup.
Click >Next. The system will display a screen detailing the information
selected to compress. To begin the compression, click >Compress.
NOTE: Make sure you have at least two good backups of the
data files before you begin the compression. Once the
compression option begins, you must allow the system to
complete the process. If you experience a power failure or if
something interrupts the compression process, the system
will require you to restore a backup.
If you are operating on a network, make sure that all users
have logged off of CertiflexDimension. The compression
program will not operate properly if there are users, except
for you, logged on to the CertiflexDimension program.
The amount of time the compression program takes is dependent upon the
number of transactions currently in the history file and the speed of your
machine. We recommend that you do not perform this option during the busy
part of your day because once you start the compression, you cannot stop the
process for any reason without restoring a backup.
Once the compression program is complete, the system will have deleted all
history transactions for the selected program through the selected date. The
system will not be able to access any transactions prior to the compress
through date without restoring a backup.
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